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With the default value, some parameters are not written to the file.

1. File title

<?xml version="1.0" encoding="UTF-8"?>

Description of the XML file version and encoding.

2. Information about file, <Source>

<Source Type="DipTrace-Schematic" Version="4.3.0.3" Units="inch">

Type="DipTrace-Schematic" – file created in DipTrace Schematics;

Version="4.3.0.3" – version of the file format;

Units="inch" – Measurement units of dimensions in the file:
mm – millimetres;
inch – inches;
mil – mils.

3. Component Library used in the project, <Library>.

<Library Type="DipTrace-ComponentLibrary" Version="4.3.0.3" Units="inch">
 {...}
</Library>

Fully corresponds to the description of the Component Editor XML format. Each component is 
assigned a unique "ComponentStyle" to associate it with the schematic (4.7.1.1).

4. Schematic description section, <Schematic>

4.1. Schematic sheet settings, <SheetSettings>

4.1.1. Display of Titles, <DisplayTitles>

<DisplayTitles>Y</DisplayTitles>

DisplayTitles Bool Display of titles on the sheets:
"Y" – enabled;
"N" – disabled.

4.1.2. Sheet borders display, <DisplaySheet>

<DisplaySheet>Y</DisplaySheet>

DisplayTitles Bool Sheet borders display:
"Y" – enabled;
"N" – disabled.
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4.1.3. Active sheet, <ActiveSheet>

<ActiveSheet>0</ActiveSheet>

ActiveSheet Int Active sheet sequence number (Id).

4.1.4. List of individual settings of sheets, <Sheets>

<Sheets> – start of list of individual settings of sheets;
 {...} – individual settings of sheets (Sheet);
</Sheets> – end of the list of individual settings of sheets.

4.1.4.1. Individual settings of sheet, <Sheet>

4.1.4.1.1. Sheet sequence number, <Id>

<Id>0</Id>

Id Int Sheet sequence number (Id).

4.1.4.1.2. Sheet name, <Name>

<Name>Sheet 1</Name>

Name Text Sheet name.

4.1.4.1.3. Sheet type, <Type>

<Type>Normal</Type>

Type Text Sheet type:
"Normal" – ordinary sheet;
"Hierarchy Block" – hierarchy block.

4.1.4.1.4. Hierarchy block identifier, <BlockId>

<BlockId>0</BlockId>

BlockId Int Hierarchy block identifier.

4.1.4.1.5. X coordinate of displayed sheet centre, <XPos>

<XPos>0</XPos>

XPos Real X coordinate of the displayed sheet centre.
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4.1.4.1.6. Y coordinate of displayed sheet centre, <YPos>

<YPos>0</YPos>

YPos Real Y coordinate of the displayed sheet centre.

4.1.4.1.7. Sheet display scale, <Scale>

<Scale>100</Scale>

Scale Real Sheet display zoom factor.

4.1.4.1.8. Sheet width, <SheetWidth>

<SheetWidth>420</SheetWidth>

SheetWidth Real Sheet width.

4.1.4.1.9. Sheet Height, <SheetHeight>

<SheetHeight>297</SheetHeight>

SheetHeight Real Sheet height.

4.1.4.1.10. Left border margin, <LeftMargin>

<LeftMargin>5</LeftMargin>

LeftMargin Real Left border margin.

4.1.4.1.11. Top border margin, <TopMargin>

<TopMargin>5</TopMargin>

TopMargin Real Top border margin.

4.1.4.1.12. Right border Margin, <RightMargin>

<RightMargin>5</RightMargin>

RightMargin Real Right border margin.

4.1.4.1.13. Bottom border Margin, <BottomMargin>

<BottomMargin>5</BottomMargin>

BottomMargin Real Bottom border margin.
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4.1.4.1.14. Parameters of sheet zones, <BorderZones>

4.1.4.1.14.1. Display of sheet zones, <Visible>

<Visible>Y</Visible>

Visible Bool Display of sheet zones:
"Y" – enabled;
"N" – disabled.

4.1.4.1.14.2. Number of horizontal zones, <HorzZones>

<HorzZones>4</HorzZones>

HorzZones Int Number of horizontal zones.

4.1.4.1.14.3. Number of vertical zones, <VertZones>

<VertZones>4</VertZones>

VertZones Int Number of vertical zones.

4.1.4.1.14.4. Zone Template, <Standard>

<Standard>0</Standard>

Standard Int Zone Template:
"0" – ANSI;
"1" – ISO.

4.1.4.1.14.5. Font Name, <FontName>

<FontName>Tahoma</FontName>

FontName Text The name of the TrueType font. Not used for Zone Information.

4.1.4.1.14.6. Font size, <FontSize>

<FontSize>10</FontSize>

FontSize Int Font size.

4.1.4.1.14.7. Font line width, <FontLineWidth>

<FontLineWidth>-2</FontLineWidth>

FontLineWidth Int Line width for vector font:
-3 – thin;
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-2 – normal;
-1 – bold;
>0 – custom, actual value is set here.

4.1.4.1.14.8. Zone Border Display, <Border>

<Border>Y</Border>

Border Bool Zone border display:
"Y" – ON;
"N" – OFF.

4.1.4.1.14.9. Horizontal Zone Width, <HorzBorderSize>

<HorzBorderSize>5</HorzBorderSize>

HorzBorderSize Real Horizontal Zone Width.

4.1.4.1.14.10. Vertical Zone Width, <VertBorderSize>

<VertBorderSize>5</VertBorderSize>

VertBorderSize Real Vertical Zone Width.

4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>

<BottomRightBlock Width="139.7" Height="26.5937">

Width Real Title Block width.

Height Real Title Block height.

4.1.4.1.15.1. Title Block name, <Name>

<Name>ANSI (TR)</Name>

Name Text Title Block name.

4.1.4.1.15.2. List of Title Block columns, <ColumnWidths>

(4.1.4.1.15.2. List of Column Widths of Title Block, <ColumnWidths>)

<ColumnWidths> – start of the list of columns;
 {...} – column width (Item);
</ColumnWidths> – end of the list of columns.
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4.1.4.1.15.2.1. Column width, <Item>

<Item>12.7</Item>

Item Real Column width.

4.1.4.1.15.3. List of Title Block rows, <RowHeights>

(4.1.4.1.15.3. List of Row Heights of Title Block, <RowHeights>)

<RowHeights> – start of the list of rows;
 {...} – row height (Item);
</RowHeights> – end of the list of rows.

4.1.4.1.15.3.1. Row height, <Item>

<Item>6.35</Item>

Item Real Row height.

4.1.4.1.15.4. List of cell borders in Title Block column, <Cells>

<Cells>
<Item>
<Item FieldId="1" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="N"/>
<Item FieldId="2" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="Y"/>
<Item FieldId="0" TopLine="Y" BottomLine="N" LeftLine="Y" RightLine="N"/>
</Item>
<Item>
<Item FieldId="1" TopLine="Y" BottomLine="Y" LeftLine="N" RightLine="N"/>
<Item FieldId="3" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="Y"/>
<Item FieldId="0" TopLine="Y" BottomLine="N" LeftLine="N" RightLine="N"/>
</Item>
</Cells>

<Cells> – start of the list of cell borders in a column;
 {...} – cell borders in a column (Item);
</Cells> – end of the list of cell borders in a column.

4.1.4.1.15.4.1. List of cell borders in column row, <Item>

<Item>
<Item FieldId="1" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="N"/>
<Item FieldId="2" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="Y"/>
<Item FieldId="0" TopLine="Y" BottomLine="N" LeftLine="Y" RightLine="N"/>
</Item>

<Item> – start of the list of cell borders in a column row;
 {...} – cell borders in a column row (Item);
</Item> – end of the list of cell borders in a column row.

© 2023 Novarm Limited 12



4.1.4.1.15.4.1.1. Cell borders in column row, <Item>

<Item FieldId="1" TopLine="Y" BottomLine="Y" LeftLine="Y" RightLine="N"/>

FieldId Int Id of the field to which a cell belongs. 

TopLine Bool Display of the top border line of the cell:
"Y" – enabled;
"N" – disabled.

BottomLine Bool Display of the bottom border line of the cell:
"Y" – enabled;
"N" – disabled.

LeftLine Bool Display of the left border line of the cell:
"Y" – enabled;
"N" – disabled.

RightLine Bool Display of the right border line of the cell:
"Y" – enabled;
"N" – disabled.

4.1.4.1.15.5. List of Title Block fields, <Fields>

<Fields> – start of the list of fields;
 {...} – field parameters (Field);
</Fields> – end of the list of fields.

4.1.4.1.15.5.1. Title Block field parameters, <Field>

<Field Id="1" FontVector="Y" FontSize="8" FontWidth="-2" FontScale="1" FontColor="0" 
LineSpacing="1.2" TextShow="Text" TextAlign="Center" X1="0" Y1="0" X2="139.7" Y2="-
6.35">
<TextLines>
<TextLine>REVISION</TextLine>
</TextLines>
<FontName>Tahoma</FontName>
</Field>

4.1.4.1.15.5.1.1. Main parameters of the field

Id Int Field identifier (Id).

FontVector Bool "Y" – vector font;
"N" – True Type font.

FontSize Int Font Size.

FontWidth Real Line width for vector text:
-3 – thin;
-2 – normal;
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-1 – bold;
>0 – custom, actual value is set here.

FontScale Real Horizontal scale for the vector text.

FontColor Int Font Color.

LineSpacing Real Line spacing for multiline text.

TextShow Text Displayed text:
"Text";
"Sheet";
"File".

TextAlign Text Text alignment:
"Center";
"Right";
"Left".

X1 Real X shift from the top left corner of the Title Block to the top left 
corner of the field.

Y1 Real Y shift from the top left corner of the Title Block to the top left 
corner of the field.

X2 Real X shift from the top left corner of the Title Block to the bottom 
right corner of the field.

Y2 Real Y shift from the top left corner of the Title Block to the bottom 
right corner of the field.

4.1.4.1.15.5.1.2. List of text lines, <TextLines>

<TextLines> – start of the list of lines;
 {...} – list of lines (TextLine);
</TextLines> – end of the list of lines.

4.1.4.1.15.5.1.2.1. Text line, <TextLine>

TextLine Text Text line.

4.1.4.1.15.5.1.3. Font Name, <FontName>

FontName Text Name of the TrueType font.

4.1.4.1.16. Bottom-Left Title Block parameters, <BottomLeftBlock>

Same as 4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>.

4.1.4.1.17. Top-Right Title Block parameters, <TopRightBlock>

Same as 4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>.
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4.1.4.1.18. Top-Left Title Block parameters, <TopLeftBlock>

Same as 4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>.

4.1.4.1.19. External Top-Left Title Block prameters, <ExtTopLeftBlock>

Same as 4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>.

4.1.4.1.20. External Bottom-Left Title Block parameters, <ExtBottomLeftBlock>

Same as 4.1.4.1.15. Bottom-Right Title Block parameters, <BottomRightBlock>.

4.2. General settings, <Settings>

4.2.1. Part Markings, <Markings>

4.2.1.1. Font, <FontVector>

<FontVector>Y</FontVector>

FontVector Bool "Y" – vector font;
"N" – True Type font.

4.2.1.2. Font Name, <FontName>

<FontName>Tahoma</FontName>

FontName Text Name of the TrueType font.

4.2.1.3. Font size, <FontSize>

<FontSize>6</FontSize>

FontSize Int Font size.

4.2.1.4. Font Line Width, <FontWidth>

<FontWidth>-2</FontWidth>

FontWidth Int Line width for vector text.
-3 – thin;
-2 – normal;
-1 – bold;
>0 – custom, actual value is set here.

4.2.1.5. Font Scale, <FontScale>

<FontScale>1</FontScale>
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FontScale Real Horizontal scale for the vector text.

4.2.1.6. Font color used, <UsePartFontColor>

<UsePartFontColor>N</UsePartFontColor>

UsePartFontColor Bool "Y" – custom color;
"N" – standard color.

4.2.1.7. Custom font color, <FontColor>

<FontColor>4194304</FontColor>

FontColor Int Custom font color.

4.2.1.8. General markings settings for RefDes, <RefDesGlobal>

<RefDesGlobal Show="Show" ShowPart="Show" Align="Auto"/>

Show Text Show:
"Show" – show;
"Hide" – hide.

ShowPart Text Part:
"Show" – show;
"Hide" – hide.

Align Text Align:
"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto".

4.2.1.9. General markings settings for Name, <NameGlobal>

<NameGlobal Show="Show" ShowPart="Show" Align="Auto"/>

Same as 4.2.1.8. General markings settings for RefDes, <RefDesGlobal>

4.2.1.10. General markings settings for Value, <ValueGlobal>

<ValueGlobal Show="Hide" Align="Auto"/>

Show Text Show:
"Show" – show;
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"Hide" – hide.

Align Text Align:
"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto".

4.2.1.11. General markings settings for Manufacturer, <ManufacturerGlobal>

<ManufacturerGlobal Show="Hide" Align="Auto"/>

Same as 4.2.1.10. General markings settings for Value, <ValueGlobal>.

4.2.1.12. General markings settings for Datasheet, <DatasheetGlobal>

<DatasheetGlobal Show="Hide" Align="Auto"/>

Same as 4.2.1.10. General markings settings for Value, <ValueGlobal>.

4.2.1.13. List of general markings settings for Additional Fields, <AddFieldsGlobal>

<AddFieldsGlobal> – start of the list;
 {...} – Additional Field settings (AddField);
</AddFieldsGlobal> – end of the list.

4.2.1.13.1. General markings settings for Additional Field, <AddField>

<AddField Show="Hide" Align="Auto">
<Name>New Field</Name>
<Value>newfield</Value>
</AddField>

4.2.1.13.1.1. Main general markings settings for Additional Field.

Show Text Show:
"Show" – show;
"Hide" – hide.

Align Text Align:
"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto".
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4.2.1.13.1.2. Additional Field Name, <Name>

Name Text Additional Field Name.

4.2.1.13.1.3. Additional Field Value, <Value>

Value Text Additional Field Value.

4.2.2. Grid settings, <Grid>

4.2.2.1. Grid display, <Visible>

<Visible>Y</Visible>

Visible Bool "Y" – show;
"N" – hide.

4.2.2.2. Snap to grid, <Snap>

<Snap>Y</Snap>

Snap Bool "Y" – enabled;
"N" – disabled.

4.2.2.3. Grid Size, <Size>

<Size>0.635</Size>

Size Real Grid Size.

4.2.3. Origin Settings, <Origin>

4.2.3.1. Origin display, <Visible>

<Visible>Y</Visible>

Visible Bool "Y" – show;
"N" – hide.

4.2.3.2. Origin color, <AxisColor>

<AxisColor>16711680</AxisColor>

AxisColor Int Origin color.
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4.2.3.3. X coordinate of Origin, <X>

<X>10</X>

X Real X coordinate of Origin.

4.2.3.4. Y coordinate of Origin, <Y>

<Y>10</Y>

Y Real Y coordinate of Origin.

4.2.4. Line Width settings, <LineWidth>

4.2.4.1. Line Width for Wire, <Wire>

<Wire>0.1</Wire>

Wire Real Line Width for Wire.

4.2.4.2. Node Diameter, <NodeSize>

<NodeSize>1</NodeSize>

NodeSize Real Node Diameter.

4.2.4.3. Line Width for Bus, <Bus>

<Bus>0.6667</Bus>

Bus Real Line Width for Bus.

4.2.4.4. Line Width for Table, <Table>

<Table>0.3333</Table>

Table Real Line Width for Table.

4.2.4.5. Line Width for Titles, <Titles>

<Titles>0.3333</Titles>

Titles Real Line Width for Titles.
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4.2.5. Bus Connection settings, <BusConnections>

4.2.5.1. Show, <Show>

<Show>NetName</Show>

Show Text "NetName" – Net Name;
"Number" – Net Number in the bus.

4.2.5.2. Position, <Position>

<Position>Above</Position>

Position Text "Above" – above wires;
"Below" – below wires.

4.2.5.3. Font size, <FontSize>

<FontSize>4</FontSize>

FontSize Int Font size.

4.2.6. Settings of Pin Numbers, <PinNumbers>

<PinNumbers Visible="Y" Font="4"/>

Visible Text Visible:
"Show" – show;
"Hide" – hide.

Font Int Font size.

4.2.7. Hide Power and Gnd setting, <HidePower>

<HidePower>N</HidePower>

HidePower Bool Power and Gnd:
"Y" – Hide;
"N" – Show.

4.2.8. Project directory, <ProjectDir>

<ProjectDir>C:\Program Files\DipTrace\Examples</ProjectDir>

ProjectDir Text Project directory.
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4.3. Project libraries, <ProjectLibs>

4.3.1. Sorted

<ProjectLibs Sorted="N">

Sorted Bool Project libraries:
"Y" – sorted by name;
"N" – not sorted.

4.3.2. List of folders with project libraries, <Folders>

<Folders> – start of the list of folders;
 {...} – folders with libraries (Folder);
</Folders> – end of the list of folders.

4.3.2.1. Folder with project libraries, <Folder>

4.3.2.1.1. Full path to the project libraries folder, <Path>

<Path>C:\Program Files\DipTrace\Lib</Path>

Path Text Full path to the folder with the project libraries.

4.3.2.1.2. Path to the project libraries folder via environment variable, <Var>

<Var>%standardlibs%</Var>

Var Text Path to the project libraries folder via environment variable.

4.3.3. List of project library files, <Libs>

<Libs> – start of the list of files;
 {...} – library files (Lib);
</Libs> – end of the list of files.

4.3.3.1. Project library file, <Lib>

4.3.3.1.1. Full path to the project library file, <Path>

<Path>C:\Program Files\DipTrace\Lib\buzzers.lib</Path>

Path Text Full path to the project library file.

4.3.3.1.2. Path to project library file via environment variable, <Var>

<Var>%standardlibs%\buzzers.lib</Var>

Var Text Path to the project library file via environment variable.
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4.4. Design Cache library, <DesignCache>

<DesignCache Count="229"/>

Count Int Number of components at the beginning of the component library (3) that 
belong to Design Cache library.

4.5. List of project Net Classes, <NetClasses>

<NetClasses> – start of the list;
 {...} – project Net Clases (NetClass);
</NetClasses> – end of the list.

4.5.1. Project Net Class settings, <NetClass>

<NetClass Id="0" UpdateId="0" Type="Normal">
<Name>Default</Name>
</NetClass>

4.5.1.1. Main settings of project Net Class

Id Int Net Class identifier (Id).

UpdateId Int Unique Net Class number for the PCB update.
"0" for  Default.

Type Text Net Class type:
"Normal";
"Differential Pair".

4.5.1.2. Net Class name, <Name>

<Name>Default</Name>

Name Text Net Class name.

4.6. ERC Settings, <ERC>

<ERC CheckPinType="Y" CheckNotConnected="N" CheckSinglePin="Y" CheckShort="N" 
CheckPinSuperimpose="Y">
<VCCTemplate>V*</VCCTemplate>
<GNDTemplate>GND*</GNDTemplate>
</ERC>

4.6.1. Main ERC settings

CheckPinType Bool Pin Type check:
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"Y" – ON;
"N" – OFF.

CheckNotConnected Bool Not Connected Pins check:
"Y" – ON;
"N" – OFF.

CheckSinglePin Bool Nets with Single Pin check:
"Y" – ON;
"N" – OFF.

CheckShort Bool Short Circuit check:
"Y" – ON;
"N" – OFF.

CheckPinSuperimpose Bool Pin Superimposing check:
"Y" – ON;
"N" – OFF.

4.6.2. Template of names of Power Pins, <VCCTemplate>

VCCTemplate Text Template of names of Power Pins.

4.6.3. Template of names of Ground Pins, <GNDTemplate>

GNDTemplate Text Template of names of Ground Pins.

4.7. List of schematic component parts, <Components>

<Components> – start of the list;
 {...} – description of schematic component parts (Part);
</Components> – end of the list.

4.7.1. Description of schematic component part, <Part>

4.7.1.1. Main parameters of component part

<Part Id="0" UpdateId="2221" BlockId="0" ComponentStyle="CompType229" 
ComponentPart="0" AllowParts="N" PartNumber="0" Sheet="4" X="83.82" Y="-43.815" 
Angle="4.7124" HorzFlip="N" VertFlip="N" ShowNumbers="Common" ShowOrigin="N" 
CustomMarkingFont="N" MarkingFontSize="6" MarkingFontAll="N" Group="-1" Selected="N" 
Locked="N">

Id Int Identifier (Id) of schematic component part.

UpdateId Int Unique component section number (Id) for PCB update.

BlockId Int Hierarchy block identifier.

ComponentStyle Text "ComponentStyle" in component library (3).
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ComponentPart Int Part sequence number within the component ComponentStyle” 
in the component library (3).

AllowParts Bool "Enable Parts" in component properties:
"Y" – enabled;
"N" – disabled.

PartNumber Int Part number within component in the source library.

Sheet Int Number of the sheet (Id), where the component part is placed 
(4.1.4.1.1).

X Real X coordinate of the component part.

Y Real Y coordinate of the component part.

Angle Real Component part rotation angle.

HorzFlip Bool Component part:
"Y" – displayed horizontally;
"N" – not displayed horizontally.

VertFlip Bool Component part:
"Y" – displayed vertically;
"N" – not displayed vertically.

ShowNumbers Text Pin Numbers:
"Common";
"Show";
"Hide".

ShowOrigin Bool Part Origin:
"Y" – show;
"N" – hide.

CustomMarkingFont Bool Markings font size:
"Y" – custom;
"N" – default.

MarkingFontSize Int Custom markings font size.

MarkingFontAll Bool Apply font set in Schematic for all markings of the components
created in the Component Editor.
"Y" – apply;
"N" – do not apply.

Group Int Number of the group (Id), to which a section belongs, see 
<Groups> section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.

Locked Bool "Y" – Locked ;
"N" – Unlocked.

4.7.1.2. Component RefDes, <RefDes>

<RefDes>C1</RefDes>
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RefDes Text Component RefDes.

4.7.1.3. Component part RefDes, <PartRefDes>

<PartRefDes>1</PartRefDes>

PartRefDes Text Component part RefDes.

4.7.1.4. Component part name, <PartName>

<PartName>Part 1</PartName>

PartName Text Component part name.

4.7.1.5. Component part Value, <Value>

<Value>(1608)</Value>

Value Text Component part value.

4.7.1.6. Component Name, <Name>

<Name>CAP_1608(0603)</Name>

Name Text Component Name.

4.7.1.7. Component library file, <LibPath>

4.7.1.7.1. Full path to the component library file, <Path>

<Path>C:\Program Files\DipTrace\Lib\buzzers.lib</Path>

Path Text Full path to the component library file.

4.7.1.7.2. Path to the component library file via environment variable, <Var>

<Var>%standardlibs%\buzzers.lib</Var>

Var Text Path to the component library file via environment variable.

4.7.1.8. Individual marking settings for RefDes, <RefDesMarking>

<RefDesMarking Show="Common" ShowPart="Common" Align="Common" Horz="Center" 
Vert="Center" X="0" Y="0" Angle="0"/>

Show Text Show:
"Common" – apply general setting (4.2.1.8);
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"Show" – show;
"Hide" – hide.

ShowPart Text Part:
"Common" – use general setting (4.2.1.8);
"Show" – show;
"Hide" – hide.

Align Text Align:
"Common" – use general setting (4.2.1.8);
"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto";
"Position".

Horz Text Horizontal Anchor Point:
"Center";
"Right";
"Left".

Vert Text Vertical Anchor Point:
"Center";
"Bottom";
"Top".

X Real X shift from the section center (for "Position").

Y Real Y shift from the section center (for "Position").

Angle Real Rotation angle (for "Position").

4.7.1.9. Individual marking settings for Name, <NameMarking>

<NameMarking Show="Common" ShowPart="Common" Align="Common" Horz="Center" 
Vert="Center" X="0" Y="0" Angle="0"/>

Same as 4.7.1.8. Individual marking settings for RefDes, <RefDesMarking>.

4.7.1.10. Individual marking settings for Value, <ValueMarking>

<ValueMarking Show="Common" Align="Common" Horz="Center" Vert="Center" X="0" Y="0" 
Angle="0"/>

Show Text Show:
"Common" – use general setting (4.2.1.8);
"Show" – show;
"Hide" – hide.

Align Text Align:
"Common" – use general setting (4.2.1.8);
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"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto";
"Position".

Horz Text Horizontal Anchor Point:
"Center";
"Right";
"Left".

Vert Text Vertical Anchor Point:
"Center";
"Bottom";
"Top".

X Real X shift from the section center (for "Position").

Y Real Y shift from the section center (for "Position").

Angle Real Rotation angle (for "Position").

4.7.1.11. Individual marking settings for Manufacturer, <ManufacturerMarking>

<ManufacturerMarking Show="Common" Align="Common" Horz="Center" Vert="Center" X="0" 
Y="0" Angle="0"/>

Same as 4.7.1.10. Individual marking settings for Value, <ValueMarking>.

4.7.1.12. Individual marking settings for Datasheet, <DatasheetMarking>

<DatasheetMarking Show="Common" Align="Common" Horz="Center" Vert="Center" X="0" 
Y="0" Angle="0"/>

Same as 4.7.1.10. Individual marking settings for Value, <ValueMarking>.

4.7.1.13. List of Additional Fields, <AddFields>

<AddFields> – start of the list;
 {...} – description of Additional Fields (AddField);
</AddFields> – end of the list.

4.7.1.13.1. Description of Additional Field and individual settings of its marking, 
<AddField>

<AddField Type="Text" Show="Common" Align="Common" Horz="Center" Vert="Center" X="0"
Y="0" Angle="0">
<Name>Description</Name>
<Text>Dual, 30-V, 700-kHz operational amplifier</Text>
</AddField>
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4.7.1.13.1.1. Main parameters of Additional Field

Type Text Additional field value type:
"Text";
"Link".

Show Text Show:
"Common" – use general setting (4.2.1.8);
"Show" – show;
"Hide" – hide.

Align Text Align:
"Common" – use general setting (4.2.1.8);
"Center";
"Top";
"Bottom";
"Left";
"Right";
"Corner";
"Auto";
"Position".

Horz Text Horizontal Anchor Point:
"Center";
"Right";
"Left".

Vert Text Vertical Anchor Point:
"Center";
"Bottom";
"Top".

X Real X shift from the section center (for "Position").

Y Real Y shift from the section center (for "Position").

Angle Real Rotation angle (for "Position").

4.7.1.13.1.2. Additional Field Name, <Name>

Name Text Additional Field Name.

4.7.1.13.1.3. Additional Field Value, <Text>

Text Text Additional Field Value.

4.7.1.14. List of part pins, <Pins>

<Pins> – start of the list;
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 {...} – description of the part pins (Pin);
</Pins> – end of the list.

4.7.1.14.1. Description of the part pin, <Pin>

<Pin NetId="-1" NotConnected="N"/>

NetId Int Identifier of the net (Id) connected to the pin in the list of 
nets.
"-1" – not connected to any net.

NotConnected Bool "Not Connected":
"Y" – enabled;
"N" – disabled.

4.7.1.15. Category assigned to component <Category>

4.7.1.15.1. Sequence number of the category in the list, <Index>

<Category Index="0">

Index Int The number of the category assigned to component in the list.

4.7.1.15.2. Name of the category assigned to component, <Name>

<Name>Connectors</Name>

Name Text Name of the category assigned to the component.

4.7.1.15.3. List of Category types and subtypes assigned to component, 
<CategoryTypes>

<CategoryTypes> – start of the list of types and subtypes;
 {...} – list of types and subtypes (CategoryType);
</CategoryTypes> – end of the list of types and subtypes.

4.7.1.15.3.1. Type and subtype description, <CategoryType>

4.7.1.15.3.1.1. Type name and number, <Type>

<Type Index="2">Circular</Type>

Index Int Number of the type in the list of the current category.

Text Type name.

4.7.1.15.3.1.2. Subtype name and number, <SubType>

<SubType Index="2">Power DIN</SubType>
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Index Int Subtype number in the list of the current type.

Text Subtype name.

4.8. List of the schematic nets, <Nets>

<Nets> – start of the list;
 {...} – schematic nets description (Net);
</Nets> – end of the list.

4.8.1. Description of schematic net, <Net>

4.8.1.1. Main parameters of net

<Net Id="0" NetClass="0" UniteByName="N" ConnectPinByName="N" Global="N" 
CustomColor="Y" WireColor="0" Locked="N" Enabled="Y">

Id Int Net identifier (Id).

NetClass Int Net netclass identifier (Id) in the list of netclasses (4.5).

UniteByName Bool "Connect Nets by Name":
"Y" – enabled;
"N" – disabled.

ConnectPinByName Bool "Connect Net to Pins by Name":
"Y" – enabled;
"N" – disabled.

Global "Global Net for Hierarchy":
"Y" – enabled;
"N" – disabled.

CustomColor Bool Wire Color:
"Y" – Custom;
"N" – Standard.

WireColor Int Custom wire color.

Locked Bool "Y" – Locked ;
"N" – Unlocked.

Enabled Bool Net:
"Y" – exists in the schematic;
"N" – removed from the schematic.

4.8.1.2. Net name, <Name>

<Name>AP-WAKE-BT</Name>

Name Text Net name.
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4.8.1.3. List of net pins, <Pins>

<Pins> – start of the list;
 {...} – net pins (Item);
</Pins> – end of the list.

4.8.1.3.1. Net pin, <Item>

<Item Part="596" Pin="0"/>

Part Int Part identifier (Id) in the list of components (4.7.1.1.).

Pin Int Pin number in the part pins list (4.7.1.14.).

4.8.1.4. List of wires, <Wires>

<Wires> – start of the list;
 {...} – net wires (Wire);
</Wires> – end of the list.

4.8.1.4.1. Net wire, <Wire>

<Wire Id="0" Sheet="1" Connected1="Pin" Bus1="-1" Object1="709" SubObject1="0" 
Connected2="Pin" Bus2="-1" Object2="347" SubObject2="0" HiddenPower="N" CanUnhide="N" 
Arrows="None" Group="-1" Selected="N">

4.8.1.4.1.1. Main parameters of wire

Id Int Wire identifier (Id) in the net.

Sheet Int Number of sheet (Id), where the wire is placed (4.1.4.1.1).
"-1" – if "Hide Wire" is enabled.

Connected1 Int Type of the first connected object:
"Pin";
"Wire";
"Bus";
"Free".

Bus1 Int Id of the connected bus in the list of buses (4.10), if 
Connected="Bus".

Object1 Int Id of connected part in the list of schematic components (4.7), 
if Connected="Pin";
Wire Id in the list of wires (4.8.1.4) of the same net, if 
Connected="Wire";
Bus wire Id in the list of bus wires (4.10.1.3), if 
Connected="Bus".

SubObject1 Int Pin sequence number in the list of part pins (4.7.1.14), if 
Connected="Pin";
Sequence number of point in the list of net wire points 
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(4.8.1.4.1.2) if Connected="Wire";
Sequence number of point in the list of bus points 
(4.10.1.3.1.2) if Connected="Bus".

Connected2 Int Type of the second object connected:
"Pin";
"Wire";
"Bus";
"Free".

Bus2 Int Id of the connected bus in the list of buses (4.10), if 
Connected="Bus".

Object2 Int Id of connected part in the list of schematic components (4.7), 
if Connected="Pin";
Wire Id in the list of wires (4.8.1.4) of the same net, if 
Connected="Wire";
Bus wire Id in the list of bus wires (4.10.1.3), if 
Connected="Bus".

SubObject2 Int Sequence number of pin in the list of part pins (4.7.1.14), if 
Connected="Pin";
Sequence number of point in the list of net wire points 
(4.8.1.4.1.2), if Connected="Wire";
Sequence number of point in the list of bus points 
(4.10.1.3.1.2), if Connected="Bus".

HiddenPower Bool "Y" – wire is hidden if  "Hide Power and GND" is enabled;
"N" – in all other cases.

CanUnhide Bool If "Hide Wire" is enabled:
"Y" – wire can be shown again;
"N" – wire cannot be shown again.

Arrows Text Direcrion Arrows:
"None";
"Forward";
"Backward".

Group Int Number of the group (Id), to which a Wire belongs, see 
<Groups> section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.

4.8.1.4.1.2. List of points connected by wire, <Points>

<Points> – start of the list;
 {...} – connected points (Point);
</Points> – end of the list.

The points in the list are in the order they are connected by a wire.
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4.8.1.4.1.3. Points connected by wire, <Point>

<Point X="-1.27" Y="-13.97" Dir="-1"/>

X Real X coordinate of the point.

Y Real Y coordinate of the point.

Dir Int Segment orientation: 
"-1" – not set;
"0" – horizontally;
"1" – vertically.
The parameter of the second point of each segment indicates its
orientation. The parameter for the very first point in the list is 
ignored.

4.9. List of differential pair of schematic, <DifferentialPairs>

<DifferentialPairs> – start of the list;
 {...} – differential pair description (DifferentialPair);
</DifferentialPairs> – end of the list.

4.9.1. Differential pair description, <DifferentialPair>

4.9.1.1. Main parameters of differential pair

<DifferentialPair Enabled="Y" PosNet="0" NegNet="1" NetClass="1" CustomColor="Y" 
WireColor="65535">

Enabled Bool Differential pair:
"Y" – exists in the schematic
"N" – removed from the schematic.

PosNet Int Positive net of the differential pair, its Id in the list of nets of 
the schematic (4.8).

NegNet Int Negative net of the differential pair, its Id in the list of nets of 
the schematic (4.8).

NetClass Int NetClass identifier (Id) in the list of netclasses (4.5).

CustomColor Bool Diff Pair Color:
"Y" – Custom;
"N" – Standard.

WireColor Int Custom Diff Pair color.

4.9.1.2. Differential Pair name, <Name>

<Name>RX</Name>

Name Text Differential pair name.
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4.10. List of buses of the schematic, <Buses>

<Buses> – start of the list;
 {...} – schematic buses (Bus);
</Buses> – end of the list.

4.10.1. Schematic bus description, <Bus>

4.10.1.1. Main bus parameters

<Bus Id="0" Enabled="Y" Locked="N">

Id Int Bus identifier (Id) in schematic. 

Enabled Bool Bus:
"Y" – exists in the schematic;
"N" – removed from the schematic.

Locked Bool "Y" – Locked ;
"N" – Unlocked.

4.10.1.2. List of bus nets, <Nets>

<Nets> – start of the list;
 {...} – bus nets (Net);
</Nets> – end of the list.

4.10.1.2.1. Bus net description, <Net>

<Net NetId="2" ConnectionNumber="1"/>

NetId Int Identifier of the bus net (Id) in the list of schematic nets (4.8).

ConnectionNumber Int Net Number in the bus.

4.10.1.3. List of bus wires, <Wires>

<Wires> – start of the list;
 {...} – bus wires (Wire);
</Wires> – end of the list.

4.10.1.3.1. Bus wire, <Wire>

<Wire Id="1" Sheet="0" Connected1="Free" Bus1="-1" Object1="-1" SubObject1="-1" 
Connected2="Bus Connector" Bus2="-1" Object2="1" SubObject2="-1" Group="-1" 
Selected="Y">

4.10.1.3.1.1. Main parameters of the bus wire

Id Int Wire identifier (Id) in the bus. 
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Sheet Int Number of sheet (Id), where the wire is placed (4.1.4.1.1).

Connected1 Type of the first connected object:
"Bus Wire";
"Bus Connector";
"Free".

Bus1 Int Bus Id, if Connected ="Bus Wire".

Object1 Int Bus wire Id in the list of wires (4.10.1.3) of the same bus, if 
Connected ="Bus Wire";
Bus Connector Id in the list of Bus Connectors (4.11), if 
Connected ="Bus Connector".

SubObject1 Int Sequence number of point in the list of bus wire points 
(4.10.1.3.1.2), if Connected ="Bus Wire".

Connected2 Int Type of the first connected object:
"Bus Wire";
"Bus Connector";
"Free".

Bus2 Int Bus Id, if Connected ="Bus Wire".

Object2 Int Bus wire Id in the list of wires (4.10.1.3) of the same bus, if 
Connected ="Bus Wire";
Bus Connector Id in the list of Bus Connectors (4.11), if 
Connected ="Bus Connector".

SubObject2 Int Sequence number of point in the list of bus wire points 
(4.10.1.3.1.2), if Connected ="Bus Wire".

Group Int Number of the group (Id), to which a Wire belongs, see 
<Groups> section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.

4.10.1.3.1.2. List of points connected by wire, <Points>

<Points> – start of the list;
 {...} – connected points (Point);
</Points> – end of the list.

The points in the list are in the order they are connected by a wire.

4.10.1.3.1.3. Points connected by wire, <Point>

<Point X="54.61" Y="-19.05" Dir="1"/>

X Real X coordinate of the point.

Y Real Y coordinate of the point.

Dir Int Segment orientation: 
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"-1" – not set;
"0" – horizontally;
"1" – vertically.
The parameter of the second point of each segment indicates its
orientation. The parameter of the first point in the list is 
ignored.

4.11. List of schematic Bus Connectors, <BusConnectors>

<BusConnectors> – start of the list;
 {...} – schematic Bus Connectors (BusConnector);
</BusConnectors> – end of the list.

4.11.1. Description of Bus Connector, <BusConnector>

4.11.1.1. Main parameters of Bus Connector

<BusConnector Id="0" Sheet="0" X="54.61" Y="12.7" Enabled="Y" Connected="Y" Group="-1" 
Selected="N" Locked="N">

Id Int Bus Connector identifier (Id) in the schematic.

Sheet Int Number of the sheet (Id), where Bus Connector is placed 
(4.1.4.1.1).

X Real X coordinate.

Y Real Y coordinate.

Enabled Bool Bus Connector:
"Y" – exists in the schematic;
"N" – removed from the schematic.

Connected Bool Bus Connector:
"Y" – connected to bus;
"N" – not connected to bus.

Group Int Number of the group (Id), to which a Bus Connector belongs, see 
<Groups> section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.

Locked Bool "Y" – Locked ;
"N" – Unlocked.

4.11.1.2. Bus Connector name, <Name>

<Name>Port 0</Name>

Name Text Bus Connector name.
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4.12. List of shapes, <Shapes>

<Shapes> – start of the list;
 {...} – shape description (Shape);
</Shapes> – end of the list.

4.12.1. Shape description, <Shape>

4.12.1.1. Main parameters of shape

<Shape Enabled="Y" Id="0" Type="Rectangle" Sheet="0" LineWidth="0.3333" Color="9079434" 
NetId="-1" BusId="-1" Angle="0" PictureWidth="0.3333" PictureHeight="0.3333" 
PictureProportions="Y" HorzAlign="Left" VertAlign="Top" PictureTransparent="0" 
TextAlign="Left" FontVector="Y" FontSize="10" FontWidth="-2" FontScale="1" 
FontColor="12632256" LineSpacing="1.2" Group="-1" Selected="N" Locked="N">

Enabled Bool Shape:
"Y" – exists in the schematic;
"N" – removed from the schematic.

Id Int Shape identifier (Id) in the schematic.

Type Int Shape type:
"Line";
"Arc";
"Rectangle";
"FillRect";
"Obround";
"FillObround";
"Polyline";
"Polygon";
"Text".

Sheet Int Number of the sheet (Id), where the shape is placed (4.1.4.1.1).

LineWidth Real Shape line width (not filled and non-text objects only).

Color Int Shape color.

NetId Int Identifier of the net (Id) in the list of nets (4.8), to whish a text is
bound.
"-1"  – not bound to net.

BusId Int Bus identifier (Id) in the list of buses (4.10), to which a text is 
bound.
"-1" – not bound to bus.

Angle Real Angle of the text and picture in radians, counterclockwise.

PictureWidth Real Picture Width.

PictureHeight Real Picture Height.

PictureProportions Picture Proportions:
"Y" – constrain;
"N" – do not constrain.
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HorzAlign Text Horizontal text and picture anchor point:
"Center";
"Right";
"Left".

VertAlign Text Vertical text and picture anchor point:
"Center";
"Bottom";
"Top".

PictureTransparent Real Picture Transparency percentage.

TextAlign Text Text alignment:
"Center";
"Right";
"Left".

FontVector Bool "Y" – vector font;
"N" – True Type font.

FontSize Int Font size for text object.

FontWidth Real Line width for vector text:
-3 – thin;
-2 – normal;
-1 – bold;
>0 – custom, actual value is set here.

FontScale Real Horizontal scale for the vector text.

FontColor Int Font color of text object.

LineSpacing Real Line spacing for multiline text.

Group Int Number of the group (Id), to which the shape belongs, see 
<Groups> section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.

Locked Bool Change lock:
"Y" – ON, changes locked;
"N" – OFF, changes allowed.

4.12.1.2. List of shape points, <Points>

<Points> – start of the list of shape points;
 {...} – list of shape points (Point);
</Points> – end of the list of shape points.

4.12.1.2.1. Shape point coordinates, <Point>

<Point X="86.995" Y="21.59"/>

X Real X coordinate.
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Y Real Y coordinate.

4.12.1.3. Font Name, <FontName>

<FontName>Tahoma</FontName>

FontName Text Name of the TrueType font.

4.12.1.4. List of lines of "Text" shape, <TextLines>

<TextLines> – start of the list of lines;
 {...} – list of lines (TextLine);
</TextLines> – end of the list of lines.

4.12.1.4.1. Lines of "Text" shape, <TextLine>

<TextLine>Power</TextLine>

TextLine Text Text line.

4.12.1.5. Picture file, <PictureFile>

<PictureFile>
<Path>D:\Work\Tests\Pict.bmp</Path>
<Var>%pictures%\Pict.bmp</Var>
</PictureFile>

4.12.1.5.1. Full path to the picture file, <Path>

Path Text Full path to the picture file.

4.12.1.5.2. Path to the picture file via environment variable, <Var>

Var Text Path to the picture file via environment variable.

4.13. List of tables, <Tables>

<Tables> – start of the list;
 {...} – description of tables (Table);
</Tables> – end of the list.

4.13.1. Table description, <Table>

4.13.1.1. Main parameters of table

<Table Enabled="Y" Id="0" HideBorder="N" Sheet="0" X1="72.39" Y1="-21.59" X2="118.11" 
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Y2="-29.718" Orientation="0" CellWidth="15.24" CellHeight="4.064" TextAlign="Left" 
FontVector="Y" FontSize="9" FontWidth="-2" FontScale="1" FontColor="0" LineSpacing="1.2" 
Group="-1" Selected="N" Locked="N">

Enabled Bool Table:
"Y" – exists in the schematic;
"N" – removed from the schematic.

Id Int Table identifier (Id) in the schematic.

HideBorder

Sheet Int Number of the sheet (Id), where table is placed (4.1.4.1.1).

X1 Real X coordinate of the top left corner of the table.

Y1 Real Y coordinate of the top left corner of the table.

X2 Real X coordinate of the bottom right corner of the table.

Y2 Real Y coordinate of the bottom right corner of the table.

Orientation Text Table rotation angle, digrees: 
"0";
"90";
"180";
"270".

CellWidth Real Cell width.

CellHeight Cell height.

TextAlign Text Text alignment:
"Center";
"Right";
"Left".

FontVector Bool "Y" – vector font;
"N" – True Type font.

FontSize Int Font Size.

FontWidth Real Line width for vector text:
-3 – thin;
-2 – normal;
-1 – bold;
>0 – custom, actual value is set here.

FontScale Real Horizontal scale for the vector text.

FontColor Int Font Color.

LineSpacing Real Line spacing for multiline text.

Group Int Number of group (Id), to which the table belongs, see <Groups> 
section.
"-1" – does not belong to any group.

Selected Bool "Y" – Selected;
"N" – Not Selected.
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Locked Bool Change lock:
"Y" – ON, changes locked;
"N" – OFF, changes allowed.

4.13.1.2. Font Name, <FontName>

<FontName>Tahoma</FontName>

FontName Text Name of the TrueType font.

4.13.1.3. Table name, <Name>

<Name>Table</Name>

Name Text Table name.

4.13.1.4. List of width values of table columns, <ColumnWidths>

<ColumnWidths> – start of the list of the width values of the columns;
 {...} – column width (Item);
</ColumnWidths> – end of the list of the width values of the columns.

4.13.1.4.1. Column width, <Item>

<Item>12.7</Item>

Item Real Column width.

4.13.1.5. List of height values of table rows,  <RowHeights>

<RowHeights> – start of the list of the height values of the rows;
 {...} – row height (Item);
</RowHeights> – end of the list of the height values of the rows.

4.13.1.5.1. Row height, <Item>

<Item>6.35</Item>

Item Real Row height.

4.13.1.6. List of table columns, <Cells>

<Cells> – start of the list of table columns;
 {...} – table columns (Cell);
</Cells> – end of the list of table columns.
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4.13.1.6.1. List of rows in the table column, <Cell>

<Cell> – start of the list of rows in the column;
 {...} – table rows (Cell);
</Cell> – end of the list of rows in the column.

4.13.1.6.1.1. Cell parameters in the column row of table, <Cell>

4.13.1.6.1.1.1. Main parameters of cell

<Cell X1="72.39" Y1="-21.59" X2="87.63" Y2="-25.654" TextAlign="Left" FontVector="Y" 
FontSize="9" FontWidth="-2" FontScale="1" FontColor="0" LineSpacing="1.2">

X1 Real X coordinate of the top left corner of the cell.

Y1 Real Y coordinate of the top left corner of the cell.

X2 Real X coordinate of the bottom right corner of the cell.

Y2 Real Y coordinate of the bottom right corner of the cell.

TextAlign Text Text alignment:
"Center";
"Right";
"Left".

FontVector Bool "Y" – vector font;
"N" – True Type font.

FontSize Int Font Size.

FontWidth Real Line width for vector text:
-3 – thin;
-2 – normal;
-1 – bold;
>0 – custom, actual value is set here.

FontScale Real Horizontal scale for the vector text.

FontColor Int Font Color.

LineSpacing Real Line spacing for multiline text.

4.13.1.6.1.1.2. Font Name, <FontName>

<FontName>Tahoma</FontName>

FontName Text Name of the TrueType font.

4.13.1.6.1.1.3. List of lines of text in cell, <TextLines>

<TextLines> – start of the list of lines;
 {...} – list of lines (TextLine);
</TextLines> – end of the list of lines.
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4.13.1.6.1.1.3.1. Lines of text in cell, <TextLine>

<TextLine>Voltage</TextLine>

TextLine Text Text line.

4.14. Simulator parameters, <Simulator>

4.14.1. General parameters of simulator

<Simulator Type="Transient" GndNetId="7">

Type Text Simulator type:
"None";
"Small-Signal AC";
"DC Transfer Function";
"Noise";
"Transient".

GndNetId Int Identifier of the net (Id) in the list of schematic nets (4.8), selected as 
"GND Net".

4.14.2. List of selected signals, <Signals>

<Signals> – start of the list of signals;
 {...} – list of signals (Signal);
</Signals> – end of the list of signals.

4.14.2.1. Description of the selected signal, <Signal>

4.14.2.1.1. Main parameters of the signal

<Signal Type="Current" Id="9" Plotted="Y" Visible="Y" Color="3390463">

Type Text Signal type:
"Current";
"Voltage".

Id Int Signal identifier (Id).

Plotted Bool The signal in the display list is:
"Y" – selected;
"N" – not selected.

Visible Bool The signal in the graph:
"Y" – shown;
"N" – not shown.

Color Int Signal color in the graph.
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4.14.2.1.2. Signal name, <DisplayName>

<DisplayName>I (LED1)</DisplayName>

DisplayName Text The name of signal displayed in the list of signals.

4.14.3. "Small-Signal AC" settings, <SmallSignalAC>

4.14.3.1. Variation, <Variation>

<Variation>decade</Variation>

Variation Text Variation:
"decade";
"octave";
"linear".

4.14.3.2. Number of points, <NumberOfPoints>

<NumberOfPoints>10</NumberOfPoints>

NumberOfPoints Int Number of points.

4.14.3.3. Start Frequency, <StartFrequency>

<StartFrequency>0,01</StartFrequency>

StartFrequency Real Start Frequency.

4.14.3.4. Stop Frequency, <StopFrequency>

<StopFrequency>10</StopFrequency>

StopFrequency Real Stop Frequency.

4.14.4. "DC Transfer Function" settings, <DCTransferFunc>

4.14.4.1. Source Type, <SourceType>

<SourceType>Voltage</SourceType>

SourceType Text Source Type:
"Voltage";
"Current";
"Resistance";
"Temperature".
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4.14.4.2. Source RefDes, <SourceRefDes>

<SourceRefDes>B1</SourceRefDes>

SourceRefDes Text Source RefDes.

4.14.4.3. Start Value, <StartValue>

<StartValue>0</StartValue>

StartValue Text Start Value.

4.14.4.4. Step, <Step>

<Step>0,5</Step>

Step Text Step.

4.14.4.5. Stop Value, <StopValue>

<StopValue>90</StopValue>

StopValue Text Stop Value.

4.14.4.6. Second Source, <SecondSource>

<SecondSource>+</SecondSource>

SecondSource Bool Second Source:
"+" – Enabled;
"-" – Disabled.

4.14.4.7. Second Source Type, <SecondSourceType>

<SecondSourceType>Voltage</SecondSourceType>

SecondSourceType Text Second Source Type:
"Voltage";
"Current";
"Resistance";
"Temperature".

4.14.4.8. Second Source RefDes, <SecondSourceRefDes>

<SecondSourceRefDes>B1</SecondSourceRefDes>

SecondSourceRefDes Text Second source RefDes.
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4.14.4.9. Second Source Start Value, <SecondStartValue>

<SecondStartValue>0</SecondStartValue>

SecondStartValue Text Second source start value.

4.14.4.10. Second Source Step, <SecondStep>

<SecondStep>4</SecondStep>

SecondStep Text Second source step.

4.14.4.11. Second Source Stop Value, <SecondStopValue>

<SecondStopValue>20</SecondStopValue>

SecondStopValue Text Second source stop value.

4.14.5. "Transient" settings of the simulator, <Transient>

4.14.5.1. Start Time, <StartTime>

<StartTime>0</StartTime>

StartTime Text Start time.

4.14.5.2. Step, <Step>

<Step>10m</Step>

Step Text Step.

4.14.5.3. Stop Time, <StopTime>

<StopTime>2</StopTime>

StopTime Text Stop Time.

4.14.6. "Noise" settings of the simulator, <Noise>

4.14.6.1. Output Net, <OutputNet>

<OutputNet>Net 0</OutputNet>

OutputNet Text Selected output net.
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4.14.6.2. Reference Net, <ReferenceNet>

<ReferenceNet>GND Net</ReferenceNet>

ReferenceNet Text Selected reference net.

4.14.6.3. Source, <Source>

<Source>B1</Source>

Source Text Source RefDes.

4.14.6.4. Variation, <Variation>

<Variation>decade</Variation>

Variation Text Variation:
"decade";
"octave";
"linear".

4.14.6.5. Number of Points, <NumberOfPoints>

<NumberOfPoints>10</NumberOfPoints>

NumberOfPoints Int Number of points.

4.14.6.6. Start Frequency, <StartFrequency>

<StartFrequency>1k</StartFrequency>

StartFrequency Text Start frequency.

4.14.6.7. Stop Frequency, <StopFrequency>

<StopFrequency>100Meg</StopFrequency>

StopFrequency Text Stop frequency.

4.14.6.8. Points per Summary, <PointsPerSummary>

<PointsPerSummary>1</PointsPerSummary>

PointsPerSummary Int Points per summary.

4.14.7. Gnd Net Name, <GndNetName>

<GndNetName>GND</GndNetName>
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GndNetName Text Gnd net name.

4.15. List of groups, <Groups>

<Groups> – start of the list of groups;
 {...} – group descriptions (Group);
</Groups> – end of the list of groups.

4.15.1. Group description, <Group>

<Group Id="0" Enabled="Y" Selected="N"/>

Id Int Identifier (Id), group number.

Enabled Bool Grouping:
"Y" – exists in the schematic;
"N" – removed from the schematic.

Selected Bool "Y" – Selected;
"N" – Not Selected.

Novarm Limited, 01/2023
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